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Introduction

Sync Buddy is a backup and install management tool for Mac OS X users with
Palm OS handhelds. Providing worry-free backups, installs and pictures manage-
ment, Sync Buddy lets you reclaim control of your handheld. It complements the
standard synchronization by giving you direct access to your handheld’s contents.

Using Sync Buddy is as simple as launching the application on your Mac, plugging
the handheld in its USB cradle or cable and pressing the synchronization button
on the cradle/cable.

Sync Buddy provides the following benefits:
e Flat and Hierarchical file listings

Sync Buddy displays your handheld’s files in either a flat form (all files together,
which matches the real layout) or a more intuitive hierarchical directory that
shows each application and its data file(s) along in separate folders.

e Worry-free backups

To back up files on your handheld, simply drag them from the directory to any
folder on your computer. Use the Backup functionality to back up all of your
Palm handheld's contents, including third-party files and databases for the built-
in applications. Files from your handheld’s main memory can be saved in a flat or
hierarchical manner. Sync Buddy can also backup the contents of any remov-
able media inserted in the handheld.

e nstant transfers

Just drop Palm databases and applications in the handheld window to install
them without running HotSync™. To install files at specific locations on remov-
able media, just drop them at the right location like you would in the Finder. With
Sync Buddy, your handheld is as easy to handle as a disk!

e Fasy picture management

Display the pictures your handheld contains with a simple click. Use drag-and-
drop to copy pictures to iPhoto, to your computer or to any other application.
Install pictures in a snap, and delete the pictures you don't need anymore.

e Expansion card support

Drag-and-drop files to and from expansion cards (SD/MMC cards, Memory
Sticks, etc). The install and backup experience on expansion cards is better than
ever with Sync Buddy!
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e USB, Bluetooth and WiFi/network support

Sync Buddy can connect with handhelds over USB and bluetooth, but also ac-
cepts connection coming from the network. This allows you to use WiFi to con-
nect your handheld to Sync Buddy, but also to connect handhelds remotely
through the network by using Network HotSync.
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Sync Buddy and HotSync™

Why bother with Sync Buddy, when you already have HotSync™? To understand
why, here is a brief explanation of what each one does:

HotSync™, which ships with the Palm OS-based handhelds, takes care of syn-
chronizing your handheld’s address book and date book with your desktop com-
puter. This is an essential functionality if you are using both your handheld and
your Mac to handle your contacts. The downside is that you have little or no con-
trol over the full backup of your handheld, and can’t do live manipulation of your
handheld.

Sync Buddy lets you decide precisely which files to backup, restore, or install.
Sync Buddy provides a host of features, such as easy browsing of the handheld’s
file directory, incremental backups, removable media backups, pictures manage-
ment, and more!

Should | use HotSync™ or Sync Buddy? The decision is simple: use both.
Sync Buddy excels at performing backups and installing software rapidly. It man-
ages backups in a much better way than HotSync™ does, and it lets you install
software immediately. You can still use HotSync™ to synchronize the handheld’s
built-in applications (Memo-Pad, Address Book, Date Book, and so on) if you use
the desktop software from Palm.

OK, but will they conflict? Not at all. When Sync Buddy performs a backup, it does
not change backup dates on the handheld. This means that is does not alter the
way HotSync™ works, so you can safely and reliably use HotSync™ when you
need to synchronize your built-in databases, and use Sync Buddy the rest of the
time to install programs or data files and backup your handheld.

When you start Sync Buddy, it automatically deactivates HotSync™ and
The Missing Sync™ (if any is installed and active), and reactivates it once you quit.
This way, you don’t need to change your synchronization settings to use
Sync Buddy.
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Requirements and installation

Sync Buddy runs on Mac OS X 10.2 and later. There is nothing to install on your
handheld, you just need to make sure that you have a working connection be-
tween your handheld and your Mac, either using USB, Bluetooth or WiFi.

To install Sync Buddy, simply copy the Sync Buddy application to the desired lo-
cation on your computer.

Handheld compatibility

Handhelds with a serial port connecting through the PaimConnect USB adapter
are supported. Other USB adapters (like Keyspan) are currently unsupported. Di-
rect serial port connections are not supported either.

Compatible handhelds: most handhelds running Palm OS are supported. Some
handhelds may not work with Sync Buddy, though. If the handheld doesn’t work
with Palm Desktop, there are few chances it will work with Sync Buddy. Some
handhelds may work with Palm Desktop but not with Sync Buddy. This is the case
for some old Handspring Visor handhelds.

Registering Sync Buddy

After purchasing a serial number for Sync Buddy (for example from our online
store at http://www.florentpillet.com/store.html) you will receive an email with a
registration code to enter in the software. After starting up Sync Buddy, you see a
welcome dialog:

en6 Sync Buddy - Trial Period

Thank you for trying Sync Buddy. The trial period extends to 30
days after the first use of the product.

When you feel ready to purchase Sync Buddy, simply click the

Purchase button below or follow the instructions in the User
Manual.

You have 30 days left in the trial period.

Purchase... it Enter Registration I Try 3
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Click the Enter Registration button to open the serial number dialog:

a6 Sync Buddy - Registration

Thank you for registering your copy of Sync Buddy. Your
support helps us improve existing products and develop new
ones!

Io actrvate YWour rEgIﬂrﬂllﬂl‘l. D|E-EI.E|E type ‘tI"E name and 'E-ErI-El.l
number you werne provided after purchasing the software in
the fields below.

Mame |

Serial Number:

Purchase... Cancel

Registration dialog

Enter the name you received in the Name field and the serial number in the Serial
Number field. If you mistyped the information, the Register button will not high-
light: in this case, copy-paste the information from the email you received to the
fields.

Establishing USB connections

There is no specific setup to do on your handheld to connect through USB. Sim-
ply plug the handheld in its cradle (or connect it to the USB cable) and press the
HotSync button on the cradle / cable. Note that some models like the Tungsten E
come with a simple cable that doesn’t have a synchronization button. In this case,
you need to follow the handheld’s instructions for synchronization (usually,
launching the HotSync application on the handheld and pressing the HotSync
icon in the middle of the screen immediately starts a synchronization).

Note that at this time, you may only connect one device at once to Sync Buddy. If
you have multiple handhelds, we recommend that you disconnect unused hand-
helds from their cable before trying to connect the handheld you want to sync.
This is particularly true if you have certain recent models like the Palm LifeDrive or
Tungsten T5 -- leaving on of these plugged (and not synchronizing) will prevent
you from connecting to another handheld.
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Establishing Bluetooth connections

Connecting to a handheld through Bluetooth (for example, to a Treo 650) requires
pairing the Mac and the handheld so they recognize each other, then setting up
HotSync to connect over Bluetooth.

Setup your Mac for Bluetooth

e Open the Bluetooth Preferences panel in the System Preferences.

¢ In the Settings tab, make sure Bluetooth is turned On and that the Discovera-
ble checkbox is checked

e In the Sharing tab, make sure Bluetooth-PDA-Sync is enabled. If you
don’t see aBluetooth-PDA-Sync entry, you may have inadvertantly re-

moved it. In this case, you can recreate it manually. Instructions to recreate the
connection are given in the Troubleshooting section of this manual.

F

= Bluetaath
Shaw All O

Settings  Devices | Sharing !

On service Name Bluetooth Serial Port On

— E' Bluetoath File Transfer

M | Bluetooth File Exchange Stop Serial Port

[
M e e toothn=PLA =5y
Type:  Modem B

_ Show in Metwork Preferences

_|Require pairing for security

Setting up Bluetooth on the Mac

Pair your handheld with the Mac

e | auch the Prefs app on the Palm

e Select “Bluetooth”. Make sure Bluetooth is “ON” and assign a Device Name to
your handheld.
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¢ Tap the Setup Devices button
e Tap the Trusted Devices button
¢ Tap the Add Device button

¢ Above the devices list, select Nearby devices, then wait until you see your
Mac’s Bluetooth name appear

e Select the Mac’s name, tap OK

e To complete pairing the devices, enter a short text (i.e. “abc”) on the handheld. A
window will pop-up on the Mac asking you to confirm the pairing by typing the
same text.

Your handheld and your Mac are now paired.

Setup HotSync to connect over Bluetooth

Next, you need to create a new Connection entry on your handheld that points to
your Mac through Bluetooth. Here are the steps to follow:

e Open the Prefs application on your handheld

e Select the “Connection” item. The available connections appear.
e Tap the New... button

e Enter a Name for this new connection (i.e; “Bluetooth to Mac”)
¢ In the Connect to: pop-up menu, select “PC”

¢ In the Via pop-up menu, select “Bluetooth”

e Tap the Device selector and chose your Mac in the list (if you properly paired it
and added it to your trusted devices, it appears in the list)

Once you have created your new connection and saved it, start the HotSync ap-
plication on the handheld. There is a pop-up menu below the big HotSync icon in
the middle of the screen: tap it and choose the connection you just created.
Launch Sync Buddy on your Mac, then tap the HotSync icon on your handheld
screen. If you did set everything up properly, the connection will establish immedi-
ately.

Note that Bluetooth is slower than USB and Wi-Fi. Connecting the device and re-
trieving the list of files can take several seconds.
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Establishing WiFi connections

WiFi is a fast, convenient and reliable way to connect to your handheld if it sup-
ports it. You first need to set up your handheld so that it can access your WiFi
network and connect to your computer. Depending on the kind of network con-
figuration you are using, you'll either have an IP address of a full name for the
computer to connect to.

To properly setup your handheld to connect to your WiFi network, please refer to
your handheld’s documentation. Once you have done the setup and confirmed
that WiFi works (i.e. you can browse the web using your WiFi connection) you can
configure HotSync.

e Open the HotSync application on your handheld

¢ In the Options menu, select Modem Sync Prefs... and make sure “Network” is
selected in the dialog box, then tap OK.

¢ In the Options menu, select LANsync Prefs... and make sure “LANSync” is se-
lected in the dialog box, then tap OK.

¢ In the Options menu, select Primary PC Setup.... This dialog box lets you enter
the name or address of the Mac to connect to. If you have a DNS name for your
Mac, enter it in the first line. Otherwise, enter the Mac’s IP address in the second
line. Leave the Subnet Mask line empty.

e On the main HotSync screen, tap the Network push-button (above the HotSync
icon). Make sure the WiFi service is selected (in the selector right below the Hot-
Sync icon).

You are now all set on the handheld side. There is one more configuration to do
on your Mac if you are using Mac OS X’s firewall: you need to open port 14238
(TCP) so that WiFi HotSync can connect to your Mac:

e On your Mac, open the System Preferences

e Open the Sharing panel, select the Firewall tab

e Click the New... button to create a new entry

¢ In the Port Name pop-up menu, select Other

e Type 14238 in the TCP Port Number(s) field

e | eave the UDP Port Number(s) field empty

¢ In the Description field, type a description for this entry (i.e. “WiFi HotSync”)

You are now done and ready to connect over WiFi. Launch Sync Buddy on the
Mac and press the HotSync icon on your handheld’s screen. If you setup is cor-
rect, Sync Buddy should immediately connect.
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Navigating your handheld

Sync Buddy lets you freely browse what’s on your handheld, and see all the hid-
den files that you usually don’t see.

To connect your handheld, launch the Sync Buddy application on your Mac then
place the handheld in its cradle and press the cradle’s or USB cable’s synchroni-
zation button. If you are using Bluetooth or WiFi, simply start the HotSync applica-
tion on the handheld as you would for a regular synchronization.

Although your handheld’s internal memory storage is like a single folder containing
lots of files, Sync Buddy can display the contents in a structured manner (hierar-
chical view) instead of the real flat view: each application appears in its own folder,
along with its data files. Also, all files are grouped in four main groups, described
later in this section.

The main window

The main window shows the contents of your handheld. Sync Buddy offers three
main views of your handheld’s data:

e The Handheld view shows the contents of the internal memory (both RAM and
ROM) as a list of files, or as a hierarchy.

e The Cards view shows the contents of any mounted removable media. A pop-
up menu lets you switch between the cards or virtual volumes in your handheld.

e The Pictures view shows a synthetic view of the pictures stored on your hand-
held, both on internal memory and on removable media.
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N Sync Buddy - Handheld (Florent T3) -

u Vo] A X
Handhel Pictures Backup Disconnect

e —

7=|=Show: | Allfiles

ar

Mame & Size
> Applications -
k4 Built-Ins -
Address Book -=
BgndService ==
Calculatar -
Card Infa -
Date Book -=
Dial --

e DI

Expense -
HotSync ==
Language Picker -
Launcher -
Memo Fad -=
MMConduit-asch -

yF ¥ Y Y¥ vy vy vy vy vy yv vy

The main window showing the Handheld view

The toolbar lets you navigate between the Handheld, Removable Media (Cards)
and Pictures views. If there is no removable media inserted in your handheld, the
Cards icon is disabled. Note that on some handhelds like Tapwave’s Zodiac and
palmOne’s Tungsten™ T5, Palm OS maintains hidden internal volumes that are
seen as removable media in Sync Buddy.

You can customize the toolbar by control-clicking it and selecting the Customize
Toolbar item in the pop-up menu.

Drag-and-drop

To transfer files to and from your handheld, you can drag them from the handheld
window to any place on your computer, and drag files from your computer to your
handheld.
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When viewing your handheld’s main memory (in the Handheld view), you can drag
only PDB, PRC and PQA files. This restriction is enforced by Palm OS which
doesn’t allow any other kind of files in the main memory. Since there is no real
folder hierarchy in the main memory, you can drop your files anywhere in the
handheld window.

When viewing removable media, drag and drop acts like in the Finder: the place
where you drop a file is important. To make a .prc application visible in the hand-
held’s Launcher, you should drop it in the /Palm/Launcher folder. When
dropping files in the Removable Media view, the destination folder will highlight to
show where the files are going to be installed (see example below):

[ Fal

MName v
VOLUME.NAM
L 4 PALM
L 4 Launcher
@ MicroCircuit.prc  Filez.pre
i MicroCircuit_Key.pdb
[ 2 DCIM

Dragging a prc file to the /Palm/Launcher folder

If you want to install images to your handheld, it is recommended that you use the
Pictures view in Sync Buddy instead of directly dropping the images on a remov-
able card. This is to ensure consistency with the handheld’s internal storage.

To copy a whole set of files from your handheld to your computer, simply select
them all and drag them to any place you want. Note that when viewing the hand-
held’s internal memory using the hierarchical layout, the same layout will be re-
spected when copying files to your computer. Using drag-and-drop, you can
backup portions of your handheld without copying the whole contents of the
memory or the whole removable card.

The Handheld view

This view shows the contents of your handheld’s internal memory. All the files in
your handheld’s memory are stored in a flat directory. That is, there is no directory.
This shows up when you perform a synchronization using HotSync™ and Palm
Desktop, and look at your backup folder: all the files are stored in the same place.
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Selecting files to view

Sync Buddy can show you the files this way, but also offers another, more evolved
and intuitive way of displaying your files: a hierarchical view. Using the view selec-
tor under the toolbar, you can switch between the flat view and the hierarchical
view, and show only ROM, only RAM or all files.

| i=|= show v All files E]
" Mame

— ROM anly —
> Applicatiomm——

Even though all the files are stored at the same place, Sync Buddy organizes them
in groups and application folders. There are five main groups:

e Applications: contains all the third-party applications. It may happen that some
applications that shipped with your handheld are shown in this group, for techni-
cal reasons.

e Built-ins: shows the built-in applications (those that ship with your handheld).
For example, the Address Book and Calculator appear in this section.

e Libraries: this special group lists all the files known as “libraries” (used by appli-
cations to provide additional functionality). This group will matter only to the ad-
vanced users.

e Other: all files that don’t seem to belong to an application and are not classified
as System files are listed in this group. You will usually see a mix of data files,
preferences files and various other elements here.

e System: all files known to belong to the operating system. In the original
Palm OS classification, system files are files whose creator code is all lowercase
or all uppercase. This distinction tends to fade on recent devices, where many
system files don’t follow this rule (and are therefore classified by Sync Buddy in
the Other files group).
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Whenever possible, Sync Buddy groups an application and its data files together’,
In the files list, you’ll see folders carrying the application name. Expanding them,
you’ll see the application and its associated files.

Getting file information

You can get information about any file by double-clicking it or choosing Fi-
le > Get Information... in the menus. The information window shows the at-
tributes of the file.

Each file in your handheld’s internal memory is called a database, and carries many
properties. Some of them can be changed directly from Sync Buddy, like the
Backup flag that tells HotSync™ which files should be backed up during a regular
synchronization.

There are two kinds of databases: data and resource. A data database contains
only data (for example, your Address Book’s data) and shows up of the desktop
as a file with “.pdb” extension. Resource databases are applications and libraries,
as well as overlay files (containing the localized texts for an application) and show
up on the desktop as a file with “.prc” extension.

The type and creator of a file are similar to the original Macintosh type and creator
that every file carries: they help Palm OS determine the kind of each file. For ex-
ample, all applications carry the ‘appl’ type. This information is useful to ad-
vanced users.

The Last Backup date of a file is updated when the file is backed up during a
regular HotSync™ operation. To not disturb your regular HotSyncs, Sync Buddy
does not touch this date when it backs up the file during a Backup (but you can
see the file has been backed up by looking at the Backup Report).

i To group the application and its data files, Sync Buddy uses the creator code of each file. Each application has its own
unigque creator code, and its associated databases also carry this creator code. Using this information, Sync Buddy can
retrieve all the files that come with each application. Of course, if the application uses data or files that don’t carry its creator

code, Sync Buddy won’t be able to group these files with the application itself.
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o6 Database Information

) File name:

Bejeweled!
App. name: Bejeweled!
Kind: Application
Size: 275,33 KB in 189 resources
Type: 'appl' Creator: "Aw]C'
Created: 09/05/04, 15:32:06
Maodified: 09/05/04, 15:32:07
Last backup: 25/01/05, 23:45:35

Attributes
E‘ Backup on HotSync __ Prevent copying
__ Read enly __ OK to install newer
| Reset after install __ Launchable data
__ Bundled
| Recyclable " | App. info dirty
__ Hidden __ Open (not closed properly)

A Database Information window

File properties (also called “flags”) are shown in the lower half of the information
window. Most of them can be changed, except the ones that are disabled (you
can view whether they are set or not, but not change them). Any change you
make here is immediately transferred to the handheld.

Here is a quick description of each property:

e Backup on HotSync: set this property for the file to be backed up during regular
HotSync. This doesn’t influence Sync Buddy’s Backup feature, only the standard
backup that occurs during regular synchronizations.

e Read only: this file cannot be written to.

e Reset after install: after installing a new copy of this file, device should be reset.
Usually, this property is set on system patches.

e Bundled: this file should be beamed along with the application carrying the
same creator code.
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* Recyclable: rarely set, this property is set on temporary files that will be deleted
soon by the operating system.

e Hidden: this file should be hidden and does not appear in the Launcher. Usually,
these files are not visible from Sync Buddy either.

e Prevent copying: this property is set to prevent beaming of some files. You can
unset it to allow beaming to another handheld.

e OK to install newer: set on some special files that should usually not be over-
written, to allow installing a new version.

e Launchable data: set on special files that should appear in the Launcher and be
opened using the application carrying the same creator code. PQA files ("Palm
Query Applications”, web URLs, etc) are some examples of such files.

e File stream: some files are neither data or resource databases. They are data
files stored in a special format known as File Streams. You cannot change this
property, it is defined once and for all when the file is created. Pictures are ex-
amples of streamed files on some devices.

e App. info dirty: tells HotSync that the file’s categories list has been changed on
the handheld and should be synchronized. For example, it is being set when you
make changes to your Address Book categories, so that the next synchroniza-
tion transfers these changes to the desktop. After the synchronization, HotSync
unchecks the property.

e Open (not closed properly): as the name tells it, the property indicates that this
file has been left open or is currently in use by Palm OS. In some cases, this can
happen because an application forgot to close a file. Usually, you'll see this
property set on some files that Palm OS use all the time and leave open.

To modify a property, simple click its checkbox. It is usually safe to change the
Backup on HotSync, Read only and Prevent copying properties. Changing other
properties may leave the file in a unusable state. Don’t touch them unless you are
an advanced user and know exactly what you are doing!

The Removable Media view

Most Palm OS handhelds have at least one slot accepting removable storage
cards, in either SD (SanDisk), MMC (MultiMedia Card) or MS (MemoryStick) for-
mat. In addition, some handhelds like the Tungsten™ T5 and the Tapwave Zodiac
have a portion of their internal memory that acts as a removable volume, except
that it can’t be removed.
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These media act like a disk and offer a structured storage, like a hard disk. You
can create files and folders on them. In fact, removable media have a standardized
folder structure so that some types of files have predefined locations. For exam-
ple, all applications that can appear in the Launcher should be stored in a
/Palm/Launcher folder. Similarly, images are usually stored in a /DCIM/
folder (and sometimes in subfolders, when the device supports the notion of “al-
bum” storage).

Sync Buddy displays the contents of all these removable and non-removable stor-
age volumes in the Removable Media view (using the short name “Cards” in the

toolbar).
™ ) Sync Buddy - Removable Media (Florent T3) o)
r e F (T
| B @ g
Handheld Cards Pictures Backup Disconnect
Wolume:  Florent-1 = 1 E Show invisible files
Mame ¥ Size
VOLUME.NAM 44 bytes
PALM
Launcher
@ MicroCircuit.pre 207,80 KB
w MicroCircuit_Rey.pdb 1,56 KB
DCIM
Palm Photos
# l.jpg 56,55 KB
P

The Removable Media view showing a SD card
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Below the toolbar, a pop-up menu lets you select which volume (card) to view.
Whenever possible, the actual card name is displayed. A default name and card
number is shown if the card is unnamed. A special case is the BUILT IN volume
found on some palmOne™ devices which is a hidden pseudo-volume storing in-
ternal device information. This volume always carries the name BUILTIN and is

write-protected to prevent corrupting your handheld.

The Show Invisible Files checkbox lets you show or hide invisible files. An exam-
ple of invisible file is the volume name, which is stored on a card as a file named
VOLUME . NAM. This option can be interesting for advanced users.

Getting card information

You can obtain various information about a card by selecting the File > Informa-
tions sur la carte menu entry. The information dialog displays all the information
it can gather from the card, like its file system and media types, manufacturer, total
and free size, etc. You can also change the card name in the Volume Name field
and click the Rename button to apply the modification.

The Other information field shows any additional information stored by the card
manufacturer. Removable cards seldom carry that kind of information, but if you
have one which does you'll see the information there.

808 Valume Infarmation

Volume name: Florent-1

File system:

Media type:

Total size:

Free size:

Manufacturer:

Product:

Class:

Serial Number;

FAT (long names)

5D (Secure Digital)

14,17 MB

13,79 M8

Panasonic

S016B

Secure Digital Card
5016B_19A5905C100907

Other information read from card {if any):

Card information dialog
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Getting file information

Select a file then go to the File > File Information menu item to view information
about the selected file. You can rename the file, and also change some of its at-
tributes. Files stored on removable cards have less attributes than the ones stored
in the handheld’s internal memory.

806 File Information

i MicroCircuit. prc

Full path: /PALM/LauncherfMicroCircwit.pre

Volume: Flonent-1

Slze: 207,80 KB
Created: Today, 164022
Modified: Today, 16:40:34

Attributes

__| Read only | Hidden
_| System
R Archive

A file information dialog

e The System attribute is rarely used. It is set only on certain special files like the
VOLUME . NAM file at the root directory, which contains the card name. You

shouldn’t modify this attribute.

e The Archive attribute is usually turned on for regular files, though it has no real
use.

e The Hidden attribute determines whether a file should be hidden. Obviously,
Sync Buddy has an option to let you see hidden files!

¢ The Volume label attribute is set only on the root file carrying the card name.

e The Link attribute is set on files that are symbolic links to other files (much like
links on Unix systems).

Any attribute change is immediately sent to the handheld.
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Creating new folders

Select File > New Folder... to create a new folder, then enter the folder name in
the New folder sheet that appears. If no item is selected, the new folder will be
created at volume root. Otherwise, the new folder will be created at the same level
than the currently selected item.

The Pictures view

Sync Buddy offers a synthetic view of the pictures stored on your handheld under
the Pictures View. Different handhelds have different ways of storing pictures:
sometimes they are all grouped in a single file, sometimes they are spread over
multiple files. To provide an easy way of managing your pictures, the popular in-
terface of our iTreo product has been leveraged into Sync Buddy. In addition to
viewing and downloading pictures from your handheld, the Pictures View lets you
install and delete pictures right on your handheld, as you’d do it in the iPhoto ap-
plication.

On some handhelds, pictures are classified in Categories. On more recent hand-
helds, the new Album terminology is being used. Sync Buddy uses the later, even
on older handhelds, to provide a unified view of your pictures (it doesn’t really
matter what picture groups are being called, because Sync Buddy always does
the right thing to find and classify the pictures).

B8 Sync Buddy - Pictures (Florent Treo) =]
" @ o0 F o

Handhkield Pictures Delete  Backup Ditoonmect
Source:  Internal T‘
Album « All

Business

Personal (46)
Unfiled (9)

2 1070304, 15116

Imgld_ 10Marad
L 10/048/04, 1d51:58
Picturel0l_O01jamd 3
OL/O0/08, 113940
Picturel0l_01jamd 3
10/02/04, 22:11:35%

&

n Plcturel0d_12Feb0s #

5E photos, 1 selecied (25,12 KB

The pictures view showing live browsing of a Treo™ 600
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The Source pop-up menu lets you select which images to view: the Internal item
shows the pictures stored in your handheld. When removable media are present in
your device, you’ll see additional volume names appear.

The Album pop-up menu shows the various albums (or categories) available in the
selected source, along with the number of pictures in each album. By default,
Sync Buddy displays the pictures from all the albums. You can select to restrict
the displayed pictures to those in a selected album, like you would on your hand-
held.

Each picture in the list shows a thumbnail of the full-size image, as well as the
picture name and creation date. Click a picture to see it in full size in the right part
of the window.

If you have many pictures on your handheld, Sync Buddy may need some time to
retrieve all of them. For each picture that has not yet been retrieved, a gray square
appears in place of the thumbnail. Clicking the picture shows a spinning indicator
until the picture has been retrieved.

Copying pictures to your computer

To copy a picture from Sync Buddy to your computer, simply drag it with the
mouse from the list or from the full size image to the desired location. You can
drag the picture to the Finder or to any application accepting pictures, like iPhoto.

You can also drag multiple pictures at once by selecting them in the list, and drag-
ging from any of the selected pictures to the desired location.

Before dragging pictures to another application or to the Finder, you should wait
for all the thumbnails to display the picture (instead of the gray square indicating
that the picture has not been retrieved yet). Otherwise, the operation may take a
while.

Exporting pictures to other formats

Sync Buddy supports picture exports to other formats than JPEG. Select one of
more pictures in the list, then select the File > Export Selection... menu item.
You can export to many formats, including GIF, PNG, BMP, Photoshop, etc.
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e 8 Sync Buddy - Pictures (Florent T3)

™
Handheic Save As: img020_22May04.jpg Er

St Where: TestsBackup ﬂ

Albi

File Format + Exports an image into a JP2 file
PP Exports images to BMP files
Exports images to JPEG files
. Exports images to MacPaint files

Exports images to PICT files
Exports images to PNG files

1771204, 14:18:48

q i )
Elmgﬂﬂl_.ﬂﬂaﬂqﬂ Exports images to Photoshop files

-
ﬁﬂ?ﬂ%m,m:sma Exports images to QuickTime Image files

Exports images to 5GI files
; L 1
m 31707/03, 16:38:54  EXPOrts images to TGA files

FESHE Exports images to TIFF files
21/07/03, 16:38:36

A oz :

7 photos, 1 selected (31,69 KBY

Exporting pictures to other formats

Installing new pictures on your handheld

To install new pictures to your handheld, simply drag them from another applica-
tion or from the Finder to the pictures list. If the currently selected album is “All”,
the picture will be installed into the Unfiled album. This behavior is similar to the

one you’d expect to get on your handheld.

Deleting pictures from your handheld

To delete a picture or a set of pictures you can either drag them to the trash, or

select the pictures to delete and click the Delete icon in the toolbar.

Note that there is no local cache keeping your pictures around! Once you have

confirmed that you want to delete them, they’ll be gone for good.
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Managing your backups

Sync Buddy’s greatest strength is its extensive Backup management. Not only
does it make sure your handheld is properly backed up, but it also offers a variety
of options that let you fine-tune the backup to your needs. After each backup op-
eration, you’ll be provided with a complete list of the files that were retrieved.

Additionally, your data is kept organized within three main folders: RAM, ROM and
Removable Media.

The RAM folder will contain all the files that are stored in your handheld’s RAM
(volatile memory), such as Address Book or Calendar data, etc. This is the main
part of your handheld that should be backed up regularly.

The ROM folder contains all backed up files coming from your handheld’s non-
volatile/flash memory. You can select to not back up ROM files, as they are being
preserved when a hard-reset occurs. If you have moved some files to flash mem-
ory, you can also ask Sync Buddy to backup non-system ROM files so as to keep
a copy of these files on your computer, in the event your handheld is destroyed or
stolen, for example.

The Removable Media folder contains a copy of the files stored on removable cards
(SD, MMC, Memory Stick, etc). If a card is inserted in your handheld when you
backup your data, a folder will be created inside the Removable Media folder,
carrying the name you gave to that card. On some handhelds with multiple card
slots like the Tapwave Zodiac, each card is therefore backed up in a separate
folder.

Note that some handhelds like palmOne’s Tungsten™ T5, Tapwave’s Zodiac and
others have additional, hidden volumes which appear as removable media.
Sync Buddy can backup these too.

Hierarchical or flat backups?

Sync Buddy’s backup functionality can store the handheld’s internal memory as a
hierarchy of files, instead of the flat form usually stored by Palm Desktop’s backup.
Whether to use a hierarchical backup is a matter of personal taste, though we
think that it allows you to more easily find your way through the various files stored
on your handheld (on modern handhelds, there can be several hundreds of files
stored in the internal memory).
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It is to be noted that Sync Buddy may not always find all the files that belong to an
application. When a file has nothing suggesting it belongs to a particular applica-
tion, Sync Buddy puts it in the “Other” folder. We suggest that you always have a
look at this folder when you need to get the files for a specific application. We are
doing our best to make sure that Sync Buddy groups all related files together but
in some cases, it is just not possible for the software to make a successful guess.

Configuring the backup options

To start a backup, click the backup icon in the toolbar or File > Backup.... You
can configure backup options in the Backup dialog.

a0 Backup Settings

Backup type: ' Full {all files)
) Incremental {only what changed)

Files layout: ™) Hierarchical {group files by application)
_/ Flat (all files in the same folder)

Options: | Mirror (delete local files not present on device)
W Backup removable media (SD, MMC, etc)

ROM files: | Don't backup ROM files
) Backup non-system ROM files
) Backup all ROM files
Deatinaticn (aldér

Wolumes/MacintoshHD /Users/fpillet | Desktop/ TestsBackup /T3 Flarent

Choose Folder... Cancel f  Start Backup )

The Backup Settings window

The backup dialog lets you configure the backup functionality to meet your needs
and preferences.
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e Backup type: a full backup will retrieve all the files from your handheld, even if
they have not been modified since the last backup you made with Sync Buddy.
On handhelds with lots of file, a full backup can take several minutes to com-
plete. An incremental backup will check your backup folder and only retrieve
those files which have been added or modified since the last backup. This is the
option you’ll want to use most of the time.

e Files layout: determines whether backed up files are all stored in the same
folder, or if Sync Buddy should create one directory for each application and
store both the application and its data in the same folder for easy retrieval. The
files layout on disk will be similar to the layout of the Handheld view.

e Mirror: this option makes sure that not only is your backup up to date, but also
that the backup folder doesn’t contain files that have been removed from your
device. Use this option with care, as it will get rid of older files you have removed
from your handheld.

e Backup removable media: this option backs up the removable card(s) inserted
in your handheld in a separate folder carrying the card’s name, under the Re-
movable Media folder in the backup folder.

* ROM files: choose one of three options for ROM files backup. If you did not
copy anything to Flash ROM using a third-party utility, you can leave this option
at “Don’t backup ROM files”. Otherwise, setting it “Backup non-system ROM
files” will ensure all applications and data you copied to Flash are being properly
backed up, under the ROM folder in the backup folder. Finally, to backup every-
thing that sits in your handheld’s ROM, check the “Backup all ROM files” op-
tion.

e Destination folder: prior to starting a backup, you must choose the destination
folder where the files will be stored on your disk. Sync Buddy remembers the
last destination folder used for each handheld you connect with, so you will only
need to select this folder once (unless the selected folder doesn’t exist any-
more).

Tracking backup progress

Once you start the Backup operation, a progress sheet appears so you can track
the backup progress.
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MUMBER OF FILES BACKED UP / TOTAL FILES

OMHGOING TASK

Sync Buddy - Handheld

s Backyp in progress 29,317
Download: Address Book_enls

Cancel

Tiewagmy T L-a g

When backing up removable media, the total number of files indicator (see above)
will read “--” because Sync Buddy doesn’t know in advance how many files there
are on the card.

Sometimes, an error may occur during backup. Errors may occur when a file can’t
be opened because it's being used by the system, for example. When backup er-
rors occur, a list of the errors encountered will appear in the backup progress
sheet, below the progress bar.

You can cancel the backup at any time. Note that when backing up a full device or
performing a backup for the first time, the operation may take several minutes de-
pending on how much data there is on your handheld.

The backup report

After a backup operation is either completed or interrupted, Sync Buddy displays
an extensive backup report beginning with a summary to let you quickly check
what was done:
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ene Backup Report

Incremental backup complete v

Started at: 08:58:42 O
Completed at: 10:02:40
Duration: 3 minutes 58 seconds
s 527 new or changed files (28,00 ME transferred)
s 5 unchanged files (877,12 KB)

s 0 deleted files (0 bytes)
» 3 errors

Files backed up in /Yolumes /MacintoshHD /Users /fpillet/Deskiop fTestsBackup /T3 Florent

Errors happened during backup:
+ Splash-splH.prc (in ROM/Applications/Splash -splH)

Error retrieving file from handheld (data is too big and can't be
transfered using this version of HotSync)

» ImgFile-Foto.prc (in ROM/Libraries)

Errar retrieving file from handheld (data is too big and can't be
transfered using this version of HotSync)

» Jpeg-Foto.prc (in ROM/Libraries)

Errar retrieving file from handheld (data is too big and can't be
transfered using this version of HotSync)

List of new/updated files retrieved from handheld (and locally semevad files, if any):

# BlueChat.prc (in RAM//Applications/BlueChat) -
+« BF_BrainForest 3.1.pdb (in BAM/Applications/Brainforest) L4

Save repart...

The summary gives you a global overview of the time backup took, number of
changes, size transferred and error count. Below is a detailed list of all the errors,
files backed up and local files deleted from your computer (if your backup ran in
Mirror mode). A separate list is emitted for the handheld and each on the remov-
able media connected to it.

Note that all links in the backup report are clickable and point to the actual files or
folders on your hard disk. You can also save the report to disk in HTML format or
print it if needed.
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Frequently asked questions (FAQ)

» Is Sync Buddy compatible with The Missing Sync?

Yes, Sync Buddy is compatible with both HotSync / Palm Desktop and The Miss-
ing Sync. It takes care of deactivating and reactivating them so that you don’t
have to change any setting to use Sync Buddy.

» | see errors in the Backup Report. Are they serious?

It depends which files couldn’t be backed up. When saving the contents of your
handheld’s ROM, some of the files may not be readable. This is usually harmless
as the ROM contents isn’t erased by a reset, hard reset or loss of batteries.

» Can Sync Buddy work with serial connections?

Starting with Sync Buddy 2.1, serial connections over a PalmConnect USB
adapter are supported. To get this to work requires unplugging your PaimConnect
USB adapter, launching Sync Buddy, plug the PaimConnect USB adapter in your
Mac and start the synchronization on your handheld. Note that if you want to es-
tablish another connection, you’ll need to unplug and replug the adapter. Future
releases of Sync Buddy may remove this limitation.

» Why can’t | move files around on the same removable card?

This is a limitation in Palm OS which does not provide a way to directly move a file
in a different folder on a removable media. For the time being, you need to down-
load the file to your Mac, remove it from its original location on the card and install
it to its new location. We will provide a built-in workaround for this limitation in a
future release of Sync Buddy.
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Troubleshooting

You may encounter problems when using Sync Buddy. If you don’t find the an-
swers to your questions in this section, please write to
syncbuddy@florentpillet.com with a precise description of your problem, and
make sure you include information about your Mac, the version of Mac OS X you
are running, the handheld model, maker and Palm OS version.

My handheld doesn’t connect

First, make sure that you press the synchronization button on your handheld’s
cradle or cable!

If you keep having connexion problems, please contact us at the e-mail address
above so we can help you.

Known issues with some handhelds

We are aware that some handhelds may have trouble connecting with
Sync Buddy. For the time being, they are: Handspring Treo 90. If you have such a
handheld and it does work with Sync Buddy, or have another handheld that does
not work, please let us know.

Backups don’t complete

If you are experiencing disconnections during backup operations and you are run-
ning Virex, please consider uninstalling Virex and try again. We received reports of
potential incompatibility between Sync Buddy and Virex, and are investigating the
issue.

My Mac doesn’t have a Bluetooth-PDA-Sync connection

In some cases, it is possible that you lost the Bluetooth-PDA-Sync link that is re-
quired for bluetooth connection. To restore it, here is what you need to do (these
instruction apply to Mac OS X Tiger, the procedure may differ slightly on earlier
versions of Mac OS X):

e Open the System Preferences
e Open the Bluetooth preference pane

e Select the Sharing tab
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e Click the Add Serial Port Service button

e Enter this name for the new port: Bluetooth-PDA-Sync

¢ | eave the Show in Network Preferences and Require pairing for security
checkboxes unchecked.
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Version history

Below is an history of versions of Sync Buddy for Mac OS X. The most recent ver-
sions are being listed first.

¢ 2.1 - April, 2006

- Universal Binary, runs native on both Intel and PowerPC Macs.

- New preference to automatically update the handheld’s date & time upon con-
nection

- Faster backups, can now backup previously unretrievable files (eliminates the
“data too big” issue)

- Fixed connection issues with some recent Palm handhelds (LifeDrive, Tungsten
TIX, etc.)

- Fixed removable media issues with some recent Palm handhelds. The Internal
volume was not always visible or properly discovered.

- Fixed pictures installation issues on some recent Palm handhelds.

- Added support for serial connections using the PalmConnect USB adapter (see
the Troubleshooting information for instructions)

- Fixed several minor issues

- Added connection instructions and tips in the manual for WiFi and Bluetooth

¢ 2.0.2 - April 19th, 2005

- When going to upload duplicate files on a SD card, the Replace Files alert didn’t
replace the files even if you asked it to.

- Fixed some stability issues

- Fixed file transfer issues with some handhelds

- Fixed disconnection during backup of SD cards over bluetooth

- Fixed issues connecting with T5 handhelds

- Fixed error when trying to delete photos stored on SD card on Treo 600

- Pictures count was incorrect in some cases after deleting a picture

- When dropping pictures to a volume where viewing ‘All’ albums, now properly
use the “Unfiled” album as default

- Canceling a Backup didn’t cancel the current transfer

- Fixed a deadlock issue when trying to access some directory contents on re-
movable media

¢ 2.0.1 - March 16th, 2005

- Fixed connection issues with Tungsten C and some other handhelds

- Fixed a sporadic crash happening when installing or backing up pictures

- Fixed an application lockup in Preferences dialog

- Fixed issue with finding and displaying pictures on removable media

- Fixed a crash that occurred during drag-and-drop of multiple photos on the
photos list
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- Pictures count was sometimes incorrect

- Files count on removable media now honors the “Show invisible files” setting

- Continue backing up folder contents on removable media when one file failed

- Fixed a lockup that could happen when quitting the application while still con-
nected

- Fixed an issue with Backup operations not working properly after a first backup
was done in the same session, and folder names starting with a space being im-
properly handled

- Fixed a crash on OS X 10.2 when dragging files to removable media

¢ 2.0 Final - March 10th, 2005

- Fixed connexion issues that prevented m500, m515 and some Sony handhelds
from connecting

- The Cards view wasn’t showing correct file dates

- Much faster retrieval of file information

- More information in Cards view, each folder displays the total number and size of
all the files/folders it contains

- Fixed Backup issue for removable media that don’t have a name

- Better support for photos stored in /DCIM

- Display total count of photos for each volume

¢ 2.0 Public Beta 3 - March 2005

- Added French localization of application

- New “Free space” indicator on handheld, cards and pictures views

- Fixed another intermittent crash issue during Backup

- Fixed several issues with Pictures and files management on removable media

- Preliminary support for reading pictures stored by SplashPhoto on removable
media.

- Improved speed and reliability when deleting large numbers of files or deep hier-
archies from removable media.

¢ 2.0 Public Beta 2 - February 2005

- Fixed an intermittent crash issue during Backup

- Fixed an issue when switching between RAM, ROM and ALL in the handheld
view

- Fixed a handheld crash while accessing removable media on early Palm OS 5
handhelds like the Tungsten T

- Fixed issues with browsing removable media (would show only first 32 files in a
folder) and deleting folders containing more than 32 files

- Application couldn’t start on Mac OS X 10.2.x

¢ 2.0 Public Beta - February 2005
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After a complete rewrite, this is the first publicly available version of Sync Buddy
for Mac OS X. Please send your feedback to syncbuddy@florentpillet.com!
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